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Section 0: Notes for other libraries 
 SerSol is used as shorthand for Serials Solutions. 

 We worked with Serials Solutions on the report setup; specifically, we ensured the SSJ/SSIB 

number was added to the report and included in the supplied bibs so we can use it as a 

matchpoint. 

 We enter a Custom Database Name for each database in Serials Solutions, as this overrides any 

database name changes SerSol may implement. 

 We add a “Public Note” Column (Section 1, steps 10-13) because it improves the display in the 

OPAC: 

 

 The saved searches referenced are: 

o ERM Coverage SerSol Bibs: store record type B 

 
o ERM Coverage orphan SerSol bibs: store record type B 

 
o ERM Coverage empty checkins: store record type C 

 

Section 1: Downloading and converting the ssjreport 
1. In the Coverage Loads folder on the shared drive (in the file path \Acquisitions 

Dept\ERM\CoverageLoads), enter the SSJReports folder. Create a new folder with the date 

(YY.MM.DD). 

2. Log in to Serials Solutions. Navigate to Data on Demand (under Business Intelligence Tools). 

Download the report titled “ssjreport.zip” that was run on the 10th of the month. Open the .zip 

file and locate the ssjreport. Move this report without opening it to the folder you just created. 

3. Open Excel. 

4. Open the Data tab. 

5. In the “Get External Data” section at the top left, click “From Text”. 
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6. Navigate to the shared drive, find the SSJ report you downloaded, and click “Import.” 

7. The Import Wizard will open. Choose the following options: 

a. Step 1:  

Data Type: Delimited 

Start at Row: 1 

File Origin: 65001 Unicode (UTF-8) 

Click “Next” 

b. Step 2: 

Delimiter: Comma 

Text Qualifier: “ 

Click “Next” 

c. Step 3: 

Select all the columns. Change the Data Format to Text. 

Click “Finish” 

8. A dialog box will pop up: “Put the data in:” Choose Existing Worksheet =$A$1 Click “OK” 

9. Check the column headers. They should match: Id; Type; Title; ISSN; eISSN; ISBN10; ISBN13; 

StartDate; EndDate; PublicationDate; Resource; Subject; URL; Author; Provider; DatabaseCode; 

PublisherName. Make sure the italicized headers are properly mapped according to the most 

recent Conversion Rules document on the G drive - see Section 9. 

10. Insert a new column between Resource and Subject. 

11. Select all of the Resource column. Copy this. 

12. Paste this in the new blank column. 

13. Rename the first cell of the new column to Public Note. 

14. Save the file. File name: [Month]-Original; Save as type: Excel Workbook. 

15. Keep this file open. 

 

Section 2: Creating the required files for loading 
At the end of this process, you will have the following files: 

 ssjreport_journal.csv – Original Serials Solutions report 

 [Month]-Original.xlsx – the Excel file. This is needed so you can recreate any needed files 

without losing the UTF characters (see note1 below). 

 [Month]-Bigs.csv – Our two biggest collections. 

 [Month]-Leftovers.csv – Everything left after creating the other csv file. 

 Any further collections to be loaded separately. 

The files are created in this order: 

 Original 

                                                           
1
 NOTE: If any of the csv files are entered, in any way, and saved, the UTF characters will be lost. To edit or recreate 

any files, first regenerate them from the [Month]-Original.xlsx file. Do not save any changes to the [Month]-
Original file. 
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 Bigs - limit Providers column to EBSCOhost and LexisNexis; then limit Resource column to 

remove EBSCO EJS (keep everything else). 

 Leftovers - everything left, without limiters 

Create each file: 

1. Select all of the cells in the [Month]-Original file. 

2. Copy the selected cells. 

3. Open a new Excel workbook. 

4. Paste the copied cells into the new workbook. 

5. Select Row 1. On the Data ribbon, click “Filter.” 

6. Use the filter for the appropriate column to apply the needed limits. 

7. Select all the rows, including Row 1, using your mouse to highlight the cells (do not use the 

“Select All” button between the Row and Column numbers at the top left). 

8. Copy the selection. 

9. Open a new Excel workbook. 

10. Paste the copied cells into the new workbook. 

11. Use Save As to save the file. File name: [Month]-[Designation]; Save as type: CSV (Comma 

Delimited). 

12. Click “OK” for the first pop-up, and “Yes” for the second. 

13. Close the workbook that was just saved. A dialog will pop up, prompting you to save. Click 

“Don’t Save.” 

14. Return to the previous workbook with the highlighted entries. Unselect the highlighted cells, 

and re-select all except Row 1 (the headers). 

15. With the cells selected, right click and choose “Delete Row.” A dialog may pop up: “Delete entire 

sheet row?” Choose “Yes.” NOTE: Do not just hit the Delete key on your keyboard, as doing so 

will leave the empty rows in the spreadsheet. 

16. Double check: you should have two spreadsheets open ([Month]-Original, and one currently 

showing blank rows below row 1). 

17. Remove all limits. 

18. Repeat steps 6 through 17 to create the remaining files. 

 

If for any reason, a new file breakdown is needed: It is extremely important that all of the SerSol 

databases that map to a single resource record are loaded in the same file; loading them separately 

causes titles from previous loads to be included in the Titles Not In File report and deletion. Refer to the 

conversion rules to determine which databases this applies to; it may be easiest to create one file with 

ALL the ‘overlap’ databases, and separate the remaining titles into the needed files. 

 

Section 3: Checking the Providers in the Conversion Rules 
This must be done before each load, to catch any Serials Solutions changes that are not reflected in the 

Conversion Rules. 

1. Open the most recent Serials Solutions SSJ report. 
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2. Copy the entire Resource column. 

3. Open a new spreadsheet and paste the Resource column. 

4. Under the Data tab, use Remove Duplicates. 

5. Remove the column header (that says “Resources”) and sort the de-duped list alphabetically. 

6. Print this list (copy and paste it into Word and change the page layout to two columns to save 

paper) or keep it up on the screen. 

7. Open the most recent Conversion Rules document from the shared drive. 

8. Ensure that every Resource from Serials Solutions is correctly represented in the Providers 

section of the Conversion Rules. Check for spelling, capitalization, punctuation, and spaces. 

9. In Sierra, run a Create List to gather all the active resource records. 

10. Export the Resource Name and Resource ID fields. 

11. Sort the list alphabetically by Resource ID. 

12. Print the list of Resource IDs (copy and paste it into Word and change the page layout to two 

columns to save paper) or keep it up on the screen. 

13. Ensure that every Resource ID from Sierra is correctly represented in the Providers section of 

the Conversion Rules. Check for spelling, capitalization, punctuation, and spaces. 

 

Section 4: Loading Instructions 
1. Ensure the Serials Solutions MARC files have been loaded for the month - do not load coverage 

until after the MARC updates are complete. 

2. In Sierra, open Create Lists. Using one of the 125,000-record lists, gather all Serials Solutions 

bibs. Use Saved Query “ERM Coverage SerSol bibs.” If this is NOT the first list created (ie., if you 

are creating this list after a load, prior to a subsequent load), add the name of the last loaded 

file in the create list name (e.g. MS ALL SerSol Bibs after Sep-JSTOR). 

3. In Sierra, open Coverage Load. 

4. Select the file you want to load. A message will pop up – click “Yes” to preprocess the file. 

5. Beside Load Catalog, change the drop down menu to “Review” and find the list of all SerSol bibs 

created in step 2. 

6. Beside Load Coverage, stick with the default options: ISSN and Title. Make sure the box next to 

“Mark as Active” is checked. 

7. In the preprocessed data, check that the columns all look good, and that the data seems to be 

correct. Blanks in the following columns are an indicator that something is wrong: Altlookup; 

Title; Provider; Public_Note; URL. The remaining columns (ISSN; EISSN; StartDate; EndDate) may 

include blanks. 

8. Click Submit. If you are prompted for a bib template, ensure that the ermbib template is used. If 

you are prompted for a checkin template, ensure that the ermhold template is used. 

9. Monitor the Results tab. Some files take a long time (over an hour), others load in just a few 

minutes. 
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10. When the Results tab indicates that the Load Catalog is complete, create a folder in the FILE 

PATH\Acquisitions Dept\ERM\CoverageLoads\CompletionReports folder with today’s date 

(YY.MM.DD). 

11. Save each report in the created folder. If a report can be expanded (e.g. the Titles not in File 

report), expand it before saving it. The naming scheme is [File]-[Report].txt, e.g. BigColl-

Catalog.txt, BigColl-Coverage.txt, BigColl-Titles.txt, BigColl-Resources.txt, etc. 

12. In the Titles not in File tab, make a mental note of the number of titles. 

a. Select all titles and choose “Delete Selected.” 

b. In Create Lists, choose a list bigger than the number of entries in the “Titles not in File” 

tab. 

c. Click “Copy” 

d. Scroll down to find “Delete candidates from the last coverage load.” Select this one. 

e. There will be a pop-up: “Do you want to remove the file being copied from” – click Yes. 

f. Rename the list “[Initials] [Month] SerSol Delete Candidates [File]”, e.g. MS Sep SerSol 

Delete Candidates AllButJP. 

13. REPEAT steps 1 through 12 for each coverage file. 

14. If there were any changes to the Conversion Rules since the last load (e.g. we turn on a new 

database; the mapping for a database is modified; etc.), check the resource and/or bib records 

in the OPAC or Sierra to ensure that the checkins linked to the resource records correctly after 

all the coverage files have been loaded. 

15. After all the loads are done, empty the All SerSol Bibs create list that was created in step 2. 

16. Update the files on the shared drive as per the retention schedule in Section 11. 

17. Check the Resources reports to ensure that no resource appears in all reports; if so, that 

resource is no longer active and should be deleted. 

 

Section 5: Deleting Records 
1. After all the loads are complete, review the Delete Candidates lists. If there are a manageable 

number of records, check and delete each checkin individually. If there is a large number, it may 

have to wait until III runs the “dbermholdingsync” utility. Only delete checkins that have no 

863/856 fields. 

2. Ask the Site Coordinator to contact III and have them run the “dbermholdingsync” utility. 

3. After the utility has been run, choose an empty 10,000-record Create List. Click “Search”, then 

“Retrieve Saved Query”. Choose the search “ERM Coverage empty checkins”. Name the list 

“DELETE CHECKINS [Month] SerSol Empty Checkins”. 

4. If a small number of checkins are found, delete them one by one. If it is a large number, ask the 

Cataloguing Librarian to delete ONLY THE CHECKINS in this file. 

5. Choose an empty 10,000-record Create List. Click “Search”, then “Retrieve Saved Query”. 

Choose the search “MS SerSol orphan serials bibs”. Name the list “DELETE [Month] SerSol 

orphan bibs”. 

6. Ask the Cataloguing Librarian to delete the bibs in this file. 
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Section 6: What to expect in the reports 
Catalog Updates 

The following Result Messages are normal: 

“Multiple Title ([Title]) matches” 

Until Load Catalog matches on ONLY the AltLookup, there is nothing we can do about these. 

“c[number] found: as linked to b[number”] 

A previously-created checkin was found 

“ok: b[number], c[number] created” 

It did not find a bib, so it created one, then created a checkin 

“ok: c[number] created for b[number]” 

It found a bib, but no checkin for that resource, so it created a checkin 

 

Any other messages should be investigated. 

 

Coverage Updates 

The following Result Messages are normal: 

“Insert Successful” 

“Update Successful” 

 

Any other messages should be investigated. 

 

Titles not in file 

This report contains a list of titles that have had at least one 863/856 pair removed from the checkin, 

organized by resource. 

 

Resources not updated 

This report contains a list of resources that were not updated with the last load.  

 

Section 7: Fixing Problems 
Problems identified by the Catalog Updates Report 

“Multiple AltLookups” 

We have more than one Serials Solutions bib with matching 001s. Consult with Cataloguing 

Librarian. 

“putRecordOnServer adding/changing b[number] [gibberish coding]: bibtemp fatal error #386481952” 

There is a special character in the journal title. Check the bib, check what the title is supposed to 

be, and check if the title is showing correctly in Serials Solutions - if it isn’t, contact SerSol to get 

the title updated. 
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“*createWorkRecViaTemplate: addNewRecnum returned invalid record number c-1 (might exceed the 

acctunit record range” 

We have run out of checkin record numbers. Consult with the Site Coordinator. 

 

Other Problems 

Checkins not linking to resource record 

Check the resource record in the OPAC - if the checkins are not linking, no titles will display 

below the license record. To fix, run the following create list: store: Checkin; Checkin Resource 

ID = [Resource ID affected]. In the Resource record, under Related Holdings on the summary 

screen, click “Add List of Related Holdings,” select the list, and click “Add.” 

Forgot to add Public Note column before loading 

1. Open [Month]-Original.xlsx 

2. Add Public Note column like usual 

3. Save the modified file as a .csv 

4. Select and preprocess the file in Sierra 

5. Uncheck the box next to “Load Catalog”; ensure the box next to “Load Coverage” stays checked 

6. Load and check results 

 

Section 8: Considerations for changes in Serials Solutions or the ERM 

When a new database is “Subscribed” in Serials Solutions 
1. Create the resource record, and decide on the Resource ID. 

2. Subscribe to the database in Serials Solutions, and decide on the Custom Database Name. Leave 

out any unnecessary or confusing information, such as: consortium designation; title list year 

(unless it is a static list that is never updated, such as a purchase of backfiles in 2012); or, “with 

Full Text.” 

3. Map the Serials Solutions Custom Database Name to the Resource ID in the Conversion Rules. 

4. Add a tickler to the resource record to check that the checkin records linked to the resource 

correctly in the next load. 

5. Note the number of titles in the collection - if it is a very large collection, we may need more 

checkin records. Check with the site coordinator. 

When a database is changed to “Not Tracked” in Serials Solutions 

1. Ensure there is a resource advisory for the corresponding resource record. The resource 

advisory must have the resource name in it (e.g. Erudit will be cancelled on August 31, 2014. 

[Insert standard contact clause].). 

2. Add a tickler to the resource record to perform the following actions after the next load: remove 

the database from the Conversion Rules; delete the coverage in Coverage Edit; remove any 

empty checkins; and, suppress the resource record. 
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When a database is swapped for another in Serials Solutions 

1. Open existing (old) Serials Solutions database record in one tab/window, and the new database 

in another. 

2. Old database: click “Edit”. 

3. New database: click “Edit”, change Status to “Subscribed”, and click “Save”. Click “Edit” again. 

4. Copy the Custom Database Name and Public All Titles Note from the old database into the new 

database. Ensure “Display” is checked for the Public All Titles Note. 

5. New database: click “Save”. 

6. Old database: change Status to “Not Tracked” and click “Save”. 

Determining the existing Custom Database Names 

1. Log in to Serials Solutions. 

2. Under Business Intelligence Tools, click “Management Reports.” 

3. Click “Request Report.” 

4. Retrieve and open the report once it is complete. 

5. The Custom Database Name column lists the custom names for all of our resources. 

Changing an existing Resource ID in the ERM 

1. Locate the resource in Coverage Edit and update the resource name. 

2. Update the Resource ID in the resource record. 

3. Update the Resource ID in the checkins (create a list: STORE: Checkin; Checkin - Resource ID - 

equals - [previous Resource ID]. Ask the Cataloguing Librarian or Site Coordinator to update 

them using Global Edit.) 

4. Update the ConversionRulesSetup spreadsheet. 

5. Update the conversion rules. 

 

Section 9: Updating the Coverage Spreadsheet Conversion Rules 
1. Open the most recent Conversion Rules from the shared drive. 

2. Use Save As to immediately re-save the document with “NEW” at the beginning and the current 

date at the end of the file name. 

3. Open the Conversion Rules folder on the shared drive, and remove the “NEW” from the file 

name of the previous conversion rules. See Section 11: File Retention for a guide to handling 

prior conversion rules. 

4. After the document is updated (see instructions below), note the changes, the date, and your 

initials at the top of the document and save it. Select the entire document and copy it. 

5. In Sierra, open the Coverage Spreadsheet Conversion Rules and select all. Delete the current 

contents, and paste in the new rules. 

6. Click Save. 

Updating Providers 
1. The format for the providers section of the conversion rules is provider|SerSol Custom Name  

|Associated ResourceID and the providers are listed alphabetically by the SerSol Custom Name. 
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2. Replace “SerSol Custom Name” with the custom database name - copy it from Serials Solutions 

and paste it here. Note there are no spaces before it and two spaces after it. 

3. Replace “Associated ResourceID” with the Resource ID from the resource record - copy it from 

Sierra and paste it here. Note there are no spaces before it and a hard return after it. 

4. Double check the spelling, capitalization, spacing, and punctuation of both the SerSol Custom 

Name and the Associated ResourceID - any mistake in either will cause problems. 

Updating Heading Conversions 
1. Review the column headers in the ssj report from Serials Solutions. Identify the column header 

you want to map, and determine which field it needs to map to. 

2. The format for the heading conversion is fields|SerSol Header  |COVERAGE_FIELD 

3. Replace “SerSol Header” with the header from the sjj report - copy it from the report and paste 

it here. Note there are no spaces before it and two spaces after it. 

4. Replace “COVERAGE_FIELD” with the field the header should map to - copy it from an existing 

line in the conversion rules and paste it here. Note there are no spaces before it and a hard 

return after it. 

5. Double check the spelling, capitalization, spacing, and punctuation of both the SerSol Header 

and the COVERAGE_FIELD - any mistake in either will cause problems. 

6. Add the new field to the list of fields to check in Section 1. 

Updating Custom Dates 

1. Determine which new date is needed (compare the current list in the conversion rules to a 

deduped list from the ssj report). Numerical dates are automatically translated during a load; 

textual dates (eg. Fall 2013; 4 calendar years ago; May 1978; etc) must be added to the 

conversion rules. 

2. The format for date conversions is date|SerSol Date  |Numerical Date 

3. Replace “SerSol Date” with the textual date from the ssj report. Case is important; “FALL” will 

not be recognized if the conversion rules only include entries for “Fall.” 

4. Replace Numerical Date with the date to display, in yyyymmdd format. This can be truncated, 

such as just entering a year, or a year and month, to display. For seasonal conversions, use the 

following guide to assign months: Spring = 03; Summer = 06; Fall = 09; Winter = 12. 

5. Note that the conversion rule entries for “x calendar years ago” must be updated annually 

before the first load in January. 

 

Section 10: Generating brand new providers for the Coverage Spreadsheet 

Conversion Rules 
1. Open a new spreadsheet. Enter the following information: 

a. A1: provider| [No spaces after the pipe] 

b. B1: [blank for Serials Solutions database name] 

c. C1:  | [Two spaces then a pipe] 

d. D1: [blank for Resource ID] 
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e. E1: A1&B1&C1&D1 

2. Save this spreadsheet as NEW-ConversionMapping.xlsx 

3. Get a list of the Custom Database names from Serials Solutions: 

a. Log in to Serials Solutions. 

b. Under Business Intelligence Tools, click “Management Reports.” 

c. Click “Request Report.” 

d. Retrieve and open the report once it is complete. 

e. The Custom Database Name column lists the custom names for all of our resources. 

Copy this column, and paste it into the B column in the ConversionMapping 

spreadsheet. 

4. In the ConversionMapping spreadsheet, for each Custom Database Name: 

a. Determine which resource it will map to. 

b. Open the resource record, and check the Resource ID field. 

i. Does it exist and contain an appropriate Resource ID? If so, leave it. 

ii. Does it exist and contain an inappropriate Resource ID? If so, update the 

Resource ID to something more accurate. 

iii. Does the field not exist? If so, create the field and enter an appropriate 

Resource ID. 

c. Copy the text of the Resource ID field into the corresponding cell in column D. 

5. When each custom database name has been mapped to a Resource ID, autofill column E to the 

bottom. 

6. Select all of column E, and copy it. 

7. In column F, paste the values of column E. Do not perform a standard paste, or it will paste the 

formula instead of the displaying text. 

8. Open the most recent copy of the Conversion Rules word document. Select the body of the 

Providers section (but not the header, which is a row of dashes, “#provider conversion,” and 

another row of dashes) and delete it. 

9. Copy column F, and paste it below the providers header in the Conversion Rules document. 

10. At the top of the Conversion Rules document, note what was updated, e.g. # UPDATED 

providers 7Oct14/ms NOTE: the # character tells Sierra to ignore that line, so it must go in front 

of every line that is not necessary for the program to run. 

11. Use Save As to save a new copy of the Conversion Rules; include the date in the file name. 

12. Open the Coverage Spreadsheet Conversion Rules in Sierra. Select everything, and delete it. 

13. Copy the entirety of the Conversion Rules document, and paste it into the Coverage 

Spreadsheet Conversion Rules in Sierra. Click Save. 

 

Section 11: File Retention 
Completion reports (in the file path \Acquisitions Dept\ERM\CoverageLoads\CompletionReports) 
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- If there is a problem with the load, keep the completion reports for that load for a full calendar 

year. Enter the problem details in the Problem Log for that year. Keep one calendar year plus 

current. 

- If there are no problems, keep two months plus current. 

Conversion Rules (in the file path \Acquisitions Dept\ERM\CoverageLoads\ConversionRules) 

- In the main folder, keep the original file and the current files since the last load. 

- Move older files to a calendar year folder. Keep one calendar year plus current. 

SSJ Reports (in the file path \Acquisitions Dept\ERM\CoverageLoads\SSJReports) 

- Keep two months plus current. 

 

Section 12: When things go really sideways 

Skipping a load 
Bibs: Bib loads cannot be skipped, as they are “update” driven. These loads must be done in order every 

time. Coverage can only be loaded after a bib load for the corresponding month. 

Coverage: Each ssj report contains the entirety of our holdings at the moment it is generated. As such, it 

is possible to skip a load if needed, with the following considerations: 

- Skipping one load means that the data in the checkin records is actually two months out of date 

- Ensure the bib-level 856s are still available to the users 

Starting fresh 

This should only be attempted if a load has gone catastrophically wrong, eg. the entire file was 

corrupted. Think VERY CAREFULLY before following the procedure below - can the problem be fixed by 

loading from an updated/uncorrupted file? 

If there is no other conceivable fix aside from starting fresh: 

1. Create a list in Sierra to gather all of the coverage-generated checkins. The easiest way will be: 

STORE: Checkin; Checkin - INT NOTE - HAS - CREATED FROM COVERAGE LOAD 

2. Delete all of these checkins. It may be easiest to ask the Cataloguing Librarian or Site 

Coordinator to do so. 

3. Create a list in Sierra to gather all of the coverage-generated bibs. The easiest way will be: 

STORE: Bib; Bib - MARC Tag 911 - has - CREATED FROM COVERAGE LOAD 

4. Delete all of these bibs. It may be easiest to ask the Cataloguing Librarian or Site Coordinator to 

do so. 

5. Choose “Coverage Edit” from the Function list in Sierra. Select all of the resources in the 

Coverage Database, and click “Delete Resource.” Follow any prompts that come up. 
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6. Ask the Site Coordinator to ensure that we have enough checkin record numbers to ensure a 

reload will complete successfully. 

7. Load like normal. There should be no “Titles Not In File”; everything else should occur like a 

standard load. 


